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Metadata Quick Start Guide 

This information is here as a guide to the minimum requirements needed to add items to WCHO. All of 

the fields listed on this page also have more detailed entries in the cataloging guide.  There are 25 

total fields for WCHO – only the 9 listed below are required for submission.  Be sure to read the 

cataloging guide so that you know all of your options. 

 

Required fields to be entered 

For all other fields enter only if information is known, otherwise leave blank or set to the default 

setting. 

 Identifier 

 Title 

 Description 

 Digital Publisher 

 Type 

 Date digital 

 Digitization specifications 

 Cataloged by 

 Cataloged date 

Identifier: 

This is the same as the base of your file names. 

Examples: PUApic_008001 

         WCMtxt_ms45 

 

Title: 

Sentence case.  Stay under 30 characters when possible. No period necessary at end of title. 

Examples: Portrait of George Atkinson 

Main Street, Forest Grove, Oregon, 1986 

Smith, George. Letter to John Smith 

 

Description: 

No format. Use full sentences and punctuation. 

Examples: Two unidentified female Pacific University students playing badminton in front of 

McCormick Hall, 1913. 

Letter from George Smith to his brother John Smith.  In the letter, he is requesting that his 

brother join him in Oregon. 

 

Digital Publisher:  

The name of the entity submitting the item to WCHO.  If an individual, use Library of Congress 

Authority format/entry. 

Example: Pacific University Archives 

        Washington County Museum 

 

Type: 

Use DCMI Type Vocab [more at: http://dublincore.org/documents/dcmi-type-vocabulary/] 

Common Terms: 

Still Image  

Text   

http://dublincore.org/documents/dcmi-type-vocabulary/
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Date Digital: 

The date the item was digitized. Use W3C standard, YYYY-MM-DD. 

 

Digitization Specifications: 

For item in brackets, enter the actual dpi of the TIFF.  Make sure to change this statement to reflect 

the equipment you are using. 

Scanned at [#] dpi using an Epson v700 scanner. Images enhanced in Photoshop CS5.  Saved at 

the highest resolution TIFF and as a derivative JPEG. 

 

Catalogued By: 

The initials of the person who wrote the metadata, no punctuation. 

 

Catalogued Date: 

The date the metadata was written. Use W3C standard, YYYY-MM-DD. 
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Purpose 

 

This best practices guide has been created by the members of Washington County Heritage 

Online (WCHO) project.  One of the goals of WCHO is to create a standard for digitization and 

metadata that can be used by institutions throughout Washington County (and Oregon).  The 

following guidebook will help you to understand the rationale behind the chosen standards, and 

will aid you as you contribute historic materials to the project.   

 

Background 

 

Washington County Heritage Online is a collaborative project between historical and cultural 

institutions in Washington County, Oregon.  Founded in 2011, it seeks to document the unique 

heritage of Washington County.  At this stage, we are seeking to collect, digitize and display 

photographs and textual items of historic importance.  Washington County Heritage Online 

principally wants to: 

 

 collect items of historical and cultural importance  

 celebrate local history 

 encourage cooperation between archives, historical societies, libraries, museums, and 

other cultural organizations 

 allow for wider access to the unique materials found in Washington County 

 train contributors to adhere to standards that create consistency and allow for WCHO to 

contribute to regional and national projects 

 

After consulting with citizens of Washington County and reading several histories, professionally 

created or otherwise, we were able to compile a list of topics which would be pertinent to cover 

for WCHO.  We encourage you to do this for your own organization; each institution will know best 

what events, people, and activities are most important to represent.  Below is a list of possible 

topics: 

 Agricultural history 

 Women’s suffrage 

 Prohibition 

 Missionary activities 

 Urbanization  

 Leisure activities (bands, sports teams, fraternal organizations etc.) 

 Pioneer heritage 

 Military activities  
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Scanning Standards 

The following charts outline the minimum requirements for digitization of images and text items. 

These standards were derived from American Library Association, Western States Digital Standards 

Group, National Archives and Records Administration, and Library of Congress best practices. 

Creating Derivate files 

 Each photo will be scanned to create a Master file (preservation copy) in the TIFF format. 

That preservation copy will then be opened in Photoshop (or similar photo editing program), 

where it will be edited and then saved as second file in TIFF format. There will then be a raw 

Master TIFF (the preservation copy) and an enhanced TIFF (cleaned up for online viewing). 

 A derivative file, optimized for viewing online, will be created using imaging software. It is 

not necessary to rescan items to create derivatives.  The derivative file will be made from 

the edited TIFF, not the raw Master TIFF. 

 For text items, you may use this method of creating a TIFF and a derivative file.  If you do not 

want to go through this process for your text items, you may scan your items and create PDF 

files.  These PDF files are not recommended for digital preservation surrogates, but will be 

perfectly acceptable for online and reference use. 

 

The following is a chart of basic guidelines for creating TIFFs for multiple item types – more specific 

guidelines for photographs, slides, and text items are on the following pages: 
 

 Min. Resolution Minimum Color Notes for creation of preservation TIFF 

Printed Materials 

(standard books, 

pamphlets, etc.)  

300 dpi Grayscale OK; 

capture in color if 

possible 

Use higher resolution (400-600 dpi) if the text is very small 

or if there are illustrations. 

Manuscripts / 

Rare Books 

400 dpi Color Use higher resolution (600+ dpi) if the text is very small or 

hard to read. 

Photographs 400-600 dpi Color; Grayscale is 

OK for black & 

white photos 

400 dpi is usually fine; You may need a higher resolution 

(600+ dpi) for small photographs. The final image should 

measure at least 6000 pixels on the longest side. 

Slides/negatives 600 dpi Color for color 

slides, grayscale for 

black & white slides 

Slides and negatives typically require a high resolution 

(1200+ dpi). The final image should measure at least 

6000 pixels on the longest side. 

Maps 300-600 dpi Color or grayscale, 

depending on 

original 

600 dpi will capture highly detailed information and is 

good for reprinting. Lower resolutions may be 

appropriate if detail is limited. 

 

For more detailed documentation on scanning different types of materials, go to 

http://connect.ala.org/node/185648 to view the Minimum Digitization Capture Recommendations 

developed by the Preservation and Reformatting Section of the Association for Library Collections and 

Technical Services. NOTE: these Guidelines have not been officially adopted by the American Library 

Association. This is expected to happen in the next year.

http://connect.ala.org/node/185648
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Photographic Prints 

A print of an image produced by any photographic process, either originally in black and white or 

in color 

 Start with 600 dpi image resolution. 

 If image pixel count on the longest side is smaller than 3000 pixels, double the dpi from 600 

to 1200 or from 1200 to 2400, etc., to increase the pixel size to at least 3000 pixels.  

 Scan backs of print if there is information written on the back.  Also scan any documents 

that accompany the photo. 

 Image Types Bit Depth Resolution 

(dpi) 

Pixel 

dimension/ 

Image Size 

File Format 

 

Master Files B&W, toned, 

and color 

prints 

24-bit color 

(RGB) 

600 dpi 

Adjust dpi to 

achieve 3000 

pixels across 

the longest 

side; 

For square 

images try for 

2700 x 2700 

pixels 

100%  (1:1) TIFF 

(uncompressed) 

Derivative 

Files 

Access 24-bit color 

(RGB) 

150 dpi 600 pixels on 

the longest side 

JPEG (low) 
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Photographic Negatives and Slides 

Any image produced on a transparent plastic film or medium, either in a negative or positive color 

or black and white image. 

 Start with 600 dpi image resolution. 

 If image pixel count along the longest side is smaller than 3000 pixels, double the dpi from 

600 to 1200 or from 1200 to 2400, etc., to increase the pixel size to at least 3000 pixels.  

 

 Image Types Bit Depth Resolution 

(dpi) 

Pixel 

dimension/ 

Image Size 

File Format 

 

Master File 

Text on 

transparent 

media 

1-bit bitonal Adjust dpi to 

achieve 3000 

pixels across 

the longest 

side. 

100 % (1:1) TIFF(uncompressed) 

B&W 

negatives & 

positives 

8-bit 

grayscale 

Adjust dpi to 

achieve 3000 

pixels across 

the longest 

side. 

100 % (1:1) TIFF(uncompressed) 

Color 

negatives & 

positives 

24-bit color 

(RGB) 

Adjust dpi to 

achieve 3000 

pixels across 

the longest 

side. 

100 % (1:1) TIFF(uncompressed) 

Derivative 

Files 

Access 1-bit bitonal 

8-bit 

grayscale 

24-bit color 

150 dpi 600 pixels on 

the longest 

side 

JPEG (low) 
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Textual Items 

Any printed text, whether it is handwritten with low contrast or a high contrast text in a standard 

font. 

 Be sure to scan all sides where writing is present 

 To prevent ‘bleeding through’ of text from the reverse of an item, you can place archival 

paper between sheets of the item (as in a book or a multi-page letter, for instance) 

 You may either create a high resolution TIFF and JPEG of your textual items, for preservation, 

or you may scan a PDF and create a digital copy which is for access and research only. 

 Image Types Bit Depth Resolution 

(dpi) 

Pixel 

dimension/ 

Image Size 

File Format 

 

Master Files Manuscripts, 

prints, maps, 

other text 

items 

24-bit color 

(RGB) for items 

with color/8-bit 

grayscale for 

items with no 

color/images 

600 dpi 

(Adjust dpi to 

achieve 

4,000 pixels 

across 

longest 

edge) 

100%  (1:1) TIFF 

(uncompressed) 

Derivative 

Files 

Access size Same as 

above 

300 dpi 100% (1:1) JPEG (low) 

PDF Files Access Size Same as 

above 

300 dpi  PDF 
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Metadata Guidelines 

Washington County Heritage Online has based its record structure on the Dublin Core metadata 

schema.  The collection was built through scanning the historic photos and textual items using 

digitization standards adapted from the standards used by leading institutions like the Library of 

Congress and the National Archives. 

The metadata schema for Washington County Heritage Online is as follows: 

WCHO Field 
Maps to Dublin Core 

field: 
Format Example 

Identifier Identifier WCHO File Naming 

Schema 

PUApic_008001 

Title Title Sentence case The Smith family 

stands in front of 

their house 

Creator Creator LoC Authority File or 

Format 

Smith, A. T. 

Brown, Charles L. 

Description Description  The five members of 

the Smith family of 

Forest Grove stand in 

front of their house, 

1880s. 

Extent Extent  12 pages 

Transcription Description Do not use quotation 

marks. Use single 

quotes instead. 

Charles Smith 

A.T. Smith 

Katherine Smith 

Sally Smith 

William Smith 

outside the house in 

1913 

Contributors Contributors  John Milton, 

photographer 

Digital Publisher Publisher  Pacific University 

Library 

Subject.Topic Subject Library of Congress 

Subject Headings 

Students 

College trustees 

Subject.Place Subject Uses names taken from 

Oregon Geographic 

Names 

Hillsboro, Oregon 

Buxton, Oregon 

Subject.Person Subject Use Library of Congress 

Authority File or AACR2 

format 

Smith, A. T.  

Subject.Theme Subject Subject terms taken 

from the American 

History and Life 

database 

State & Local History 

 

Language Language Use ISO639-2 MARC 

code list for languages 

[eng] = English 

[spa] = Spanish 

Rights & Usage Rights WCHO Copyright Online access to this 
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boilerplates image is for research 

and educational 

purposes only.  To 

inquire about 

permissions, order a 

reproduction, or for 

more information, 

please contact 

[institution name 

and point of contact 

information]. 

Type Type DCMI Type vocabulary Still Image 

Date.Created Date-Created W3C date standard for 

specific dates 

circa 1900s 

1903-09-18 

Date.Range Coverage.Temporal Date 1890-1899 

1987 

1800-1899 

Format.Original Format-Medium AAT Vocabulary photographic prints 

slides 

Shelf.Location Source  RG.124 

Source Source  Photo Collection, 

Pacific University 

Archives 

IsPartOf IsPartOf  Sidney Harper Marsh 

Collection  

Date.Digital [none] W3C date standard 2011-09-08 

Digitization 

Specifications 

[none] You may adjust this 

based on what you 

actually use.   

Scanned at [##] dpi 

using an Epson V700. 

Images enhanced in 

Photoshop CS5. Saved 

as the highest 

resolution TIFF and also 

a derivative JPEG. 

Catalogued By [none] Initials in all-caps LAP 

Catalogued Date [none] W3C date standard 2011-09-10 

*REQUIRED FIELDS 
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Example Metadata Records 

 

Field Metadata 

Identifier PUApic_008608 

Title A new class of Native American students pose 

for a picture 

Creator  

Description New students at the Forest Grove Indian 

Training School, posing as a group. The eleven 

children are dressed in traditional Native 

American clothing. See also: PUApic_008035. 

Extent  
Transcription Davidson, Photo. Davidson, Photo, No. 43. New 

Recruits---Spokane Indians. Portland, Oregon. 

Contributors  

Digital Publisher Pacific University Library 

Subject.Topic Indians of North America 

Students 

Vocational education 

Acculturation 

Off-reservation boarding schools 

Fashion 

Subject.Place Forest Grove, Oregon 

Subject.Person Davidson, I. G. 

Subject.Theme History of the Americas 

Native American Studies 

United States History 

Western United States History 

Language [eng] 

Rights & Usage Online access to this image is for research and 

educational purposes only.  To inquire about 

permissions, order a reproduction, or for more 

information, please contact the Pacific 

University Archives at archives@pacificu.edu. 

Type Still Image 

Date.Created 1880-1885 

Date.Range 1880-1885 

Format.Original photographic prints 

Shelf.Location  

http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/New
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/Grove
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/Indian
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/Training
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/posing
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/group
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/eleven
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/children
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/dressed
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/traditional
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/Native
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/American
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/clothing
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/See
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/also:
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/PUApic_008035
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/Davidson
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/Photo
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/Davidson
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/Photo
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/No
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/43
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/New
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/Recruits---Spokane
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/Indians
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/Portland
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/Oregon
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/Indians%20of%20North%20America
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/%20Students
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/%20Vocational%20education
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/%20Acculturation
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/%20Off-reservation%20boarding%20schools
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/%20Fashion
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Source Photo Image Collection, Pacific University 

Archives 

isPartOf  

Date.Digital 2011-07-28 

Digitization Specifications Scanned at 600 dpi using an Epson V700. 

Images enhanced in Photoshop CS5. Saved as 

the highest resolution TIFF and also a derivative 

JPEG. 

Catalogued By EAV 

Catalogued Date 2011-08-01 

 

Example Two 

 
 

Field Metadata 

Identifier WCMpic_000045 

Title Robert Weatherred, High Jump 

Creator  

Description A young man, Robert Weatherred, in white 

shorts and tank-top is attempting a high-jump 

while a number of men and boys watch in a 

grassy field.  

Extent  

Transcription Robert Weatherred doing jump 

Contributors  

Digital Publisher Washington County Museum 

Subject.Topic Athletics 

Jumping 

Subject.Place Hillsboro, Oregon 

Subject.Person Weatherred, Robert 

Subject.Theme Art & Entertainment 

Local & State History 

Social History 

Language [eng] 

Rights & Usage Online access to this image is for research and 

educational purposes only.  To inquire about 

permissions, order a reproduction, or for more 

information, please contact the Washington 

http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/young
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/man
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/white
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/shorts
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/tank-top
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/is
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/attempting
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/high-jump
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/while
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/number
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/men
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/boys
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/watch
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/grassy
http://cdm16047.contentdm.oclc.org/cdm/search/searchterm/field
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County Museum at 

Librarian@WashingtonCountyMuseum.org. 

Type Still Image 

Date.Created circa 1930s 

Date.Range 1930-1939 

Format.Original photographic prints 

Shelf.Location  

Source Robert L. Benson Research Library, Washington 

County Museum 

isPartOf  

Date.Digital 2011-07-28 

Digitization Specifications Scanned at 600 dpi using an Epson v700 

scanner. Images enhanced in Photoshop 

Elements. Saved at the highest resolution TIFF 

and as a derivative JPEG. 

Catalogued By LMD 

Catalogued Date 2011-09-01 

 

Example Three 

 

Field Metadata 

Identifier PUAman_MS69 

Title Letter, Marcus Whitman to Alanson Hinman 

Creator Whitman, Marcus, author 

Description Marcus Whitman writes to Alanson Hinman 

about his trials and tribulations as a missionary 

and doctor among the Native Americans. This 

letter was written roughly one month before 

the Whitman Massacre. 

Extent 4 pages 

Transcription  

Contributors  

Digital Publisher Pacific University Archives 

Subject.Topic Missionaries 

Indians of North America 

Subject.Place Wailatpu, Washington 

Subject.Person Whitman, Marcus 
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Hinman, Alanson 

Subject.Theme Social History 

Language [eng] 

Rights & Usage Online access to this image is for research and 

educational purposes only.  To inquire about 

permissions, order a reproduction, or for more 

information, please contact the Pacific 

University Archives at archives@pacificu.edu. 

Type Text 

Date.Created 1847-10-23 

Date.Range 1847 

Format.Original letters 

Shelf.Location MS.69 

Source Pacific University Archives 

isPartOf Marcus Whitman letters to Alanson Hinman 

Date.Digital 2012-06-22 

Digitization Specifications Scanned at 600 dpi using an Epson v700 

scanner. Images enhanced in Photoshop 

Elements. Saved at the highest resolution TIFF 

and as a derivative JPEG. 

Catalogued By LPZ 

Catalogued Date 2012-08-17 
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Project Glossary 

Administrative metadata: n. Data that is necessary to manage and use information resources and 

that is typically external to informational content of resources.  Administrative metadata often 

captures the context necessary to understand information resources, such as creation or 

acquisition of the data, rights management, and disposition. 

Anglo-American Cataloging Rules 2: n. (AACR2) A standard for creating library catalog records, 

especially library collections, including the consistent description of those materials and the 

formation and assignment of access points under which those descriptions are arranged. 

 

Archives: n. 1. Materials created or received by a person, family, or organization, public or private, 

in the conduct of their affairs and preserved because of the enduring value contained in the 

information they contain or as evidence of the functions and responsibilities of their creator, 

especially those materials maintained using the principles of provenance, original order, and 

collective control; permanent records.  2. The division within an organization responsible for 

maintaining the organization's records of enduring value.  3. An organization that collects the 

records of individuals, families, or other organizations; a collecting archive.  4. The professional 

discipline of administering such collections and organizations.  5. The building (or portion thereof) 

housing archival collections.  6. A published collection of scholarly papers, especially as a 

periodical. 

 

Archival Image: an image held within an archive.  The image tends to be in its original form. 

 

Compression: n. A process that reduces the amount of space necessary for data to be stored or 

transmitted. 

 

Art and Architecture Thesaurus:  n. (AAT) A controlled vocabulary that includes terms useful for 

describing and indexing collections of fine art, architecture, decorative arts, archival materials, 

and material culture. Created by the Getty Research Institute.  

 

DCMI: (Dublin Core Metadata Initiative) The Dublin Core Metadata Initiative is an open 

organization engaged in the development of interoperable metadata standards that support a 

broad range of purposes and business models. DCMI's activities include work on architecture and 

modeling, discussions and collaborative work in DCMI Communities and DCMI Task Groups, 

annual conferences and workshops, standards liaison, and educational efforts to promote 

widespread acceptance of metadata standards and practices. 

 

CONTENTdm: is digital collection management software that allows for the upload, description, 

management and access of digital collections. It is Unicode and Z39.50 compatible. CONTENTdm 

can handle documents, PDFs, finding aids (including Encoded Archival Description, or EAD), 

images, videos, and audio files. It can also handle content so that multipage documents, scores, 

or books can be uploaded and organized into chapters, books or by page number. CONTENTdm 

is also able to display six-sided, multidimensional objects. CONTENTdm is owned by OCLC. 

 

Controlled Vocabulary: n. A limited set of terms and phrases used as headings in indexes and as 

access points in catalogs. 

Descriptive metadata: n. Information that refers to the intellectual content of material and aids 

discovery of such materials.  Descriptive metadata allows users to locate, distinguish, and select 

http://en.wikipedia.org/wiki/Z39.50
http://en.wikipedia.org/wiki/PDF
http://en.wikipedia.org/wiki/Finding_aid
http://en.wikipedia.org/wiki/Encoded_Archival_Description
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materials on the basis of the material's subjects or 'aboutness.' It is distinguished from information 

about the form of the material, or its administration. 

DPI (dots per inch): a measurement related to resolution.  It measures the number of pixels per inch 

in a digital image.  Generally speaking, the more pixels per inch, the higher the quality. 

 

Dublin Core: n. (DC, abbr.)  A standard (ISO 15836, ANSI Z39.85) that defines metadata elements 

used to describe and provide access to online materials. 

 

ISO639-2: codes for the representation of names of languages.  List controlled by the Library of 

Congress. 

 

JPEG (Joint Photographic Experts Group): n. A standard (ISO/IEC 10918) that specifies a digital 

graphic file format that can reproduce a large color space and that can compress the data to 

minimize the file size. 

 

Library of Congress Authority File: The Library of Congress has a vocabulary for more than just 

subjects.  The Library of Congress Authorities, as the collective group is known, includes the Subject 

Headings, Name Authorities, and the Thesaurus of Graphic Materials.  For this project, we will use 

the Subject Headings (LCSH) and the Name Authority File (LCNAF), if it is available.  If the Name is 

not included, we will use the LCNAF format. 

 

Library of Congress Subject Headings (LCSH): n. A controlled vocabulary typically used to provide 

topical access points for catalog records. 

 

MARC: n. A data communications format that specifies a data structure for bibliographic 

description, authority, classification, community information, and holdings data. 

 

Metadata: n. A characterization or description documenting the identification, management, 

nature, use, or location of information resources (data). 

 

Pixels: n. 1. An element in an array that forms an image.  2. A unit of measure used to describe the 

size or resolution of an image. 

 

Metadata harvesting: Enables uses of data objects by organizations and services other than the 

creator/owner, and allows for objects to be shared within a larger community.  For example, our 

metadata is harvestable so that it can eventually be incorporated into the library catalog 

WorldCat and projects like the Oregon Digital Library. 

Oregon Geographic Names: a book produced by the Oregon Historical Society.  It includes a 

complete listing of geographic locations in Oregon’s history.  The full citation is: MacArthur, Lewis A. 

and Lewis L. MacArthhur. Oregon Geographic Names, 5th Edition. Portland, OR: Oregon Historical 

Society Press, 2003. 

 

Resolution: n. A measure of the sharpness and detail in an image or optical system. 

 

TIFF (Tagged Image File Format): n. A standard (ISO 12234-2) for storing a raster graphic and 

metadata that describes the image content and characteristics. 

 

W3C: The World Wide Web Consortium (W3C) is an international community where Member 

organizations, a full-time staff, and the public work together to develop Web standards. 



21 
 

 

Taken from the Society of American Archivist’s Glossary of Archives and Records Terminology.  

Found at www.archivists.org/glossary. 
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Washington County Heritage Online 

Guides and Workflows 

 
The following documents are supplied for your use when you join WCHO.  These provide step by 

step directions for all steps of the project, including scanning, writing metadata, and uploading.  

The guides and workflows will duplicate some of the information in this guide.  If you are missing 

any of these guides, or have suggestions for clarifications and/or improvements, please contact 

the Project Manager at lindsay.prescott@pacificu.edu.  

 

 Metadata Quick Start Guide 

 Best Practices Guide 

 Collection Criteria Guide 

 WCHO File Naming Schema 

 Scanning Procedures 

 Readying Digital Files 

 Collection Building Overview 

 WCHO Cataloging Guide 

 

 

mailto:lindsay.prescott@pacificu.edu
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Resources 
 

American Library Association. Minimum Digitization Capture Recommendations, June 2012: 

http://connect.ala.org/node/185648.  

 

Arizona Memory Project’s Digital Project Guidelines and Metadata Guidelines: 

http://azmemory.lib.az.us/cdm4/index.php#5.  

BCR’s CDP Digital Imaging Best Practices v.2.0  June 2008: 

http://www.bcr.org/dps/cdp/best/digital-imaging-bp.pdf. 

Dublin Core Metadata Initiative. http://dublincore.org/.  

Getty’s Art and Architecture Thesaurus: 

http://www.getty.edu/research/tools/vocabularies/aat/index.html.  

Idaho Digital Memories’ Metadata Best Practices: http://idig.lili.org/node/74. 

Library of Congress Authorities and Vocabularies. http://id.loc.gov/.  

Peterson, Kit A. (2005). Introduction to basic measures of a digital image for pictorial collections. 

Washington DC: Library of Congress. http://www.loc.gov/rr/print/tp/IntroDgtlImage.pdf. 

 

Peterson, Kit A. (2004). Digital master images – sample technical specifications for photographic 

collections.  Washington DC: Library of Congress. 

http://www.loc.gov/rr/print/tp/DgtlMastersSamplSpecsSelctdRcmndFinal7_2004.pdf. 

 

Society of American Archivists. Glossary of Archives and Records Terminology. 

http://www.archivists.org/glossary.  

 

Technical Guidelines for Digitizing Archival Materials for Electronic Access: Creation of Production 

Master Files – Raster Images, U.S. National Archives and Records Administration (June 2004). 

http://www.archives.gov/preservation/technical/guidelines.html. 

 

 

 

 

 

 

http://connect.ala.org/node/185648
http://azmemory.lib.az.us/cdm4/index.php#5
http://www.bcr.org/dps/cdp/best/digital-imaging-bp.pdf
http://dublincore.org/
http://www.getty.edu/research/tools/vocabularies/aat/index.html
http://idig.lili.org/node/74
http://id.loc.gov/
http://www.loc.gov/rr/print/tp/IntroDgtlImage.pdf
http://www.loc.gov/rr/print/tp/DgtlMastersSamplSpecsSelctdRcmndFinal7_2004.pdf
http://www.archivists.org/glossary
http://www.archives.gov/preservation/technical/guidelines.html
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Collection Criteria Guide 

Washington County Heritage Online is a collaborative project between historical and cultural 

institutions in Washington County, Oregon.  Founded in 2011, it seeks to document the unique 

heritage of Washington County.  In this stage of the project we are seeking to collect, digitize and 

display photographs and textual items of historic importance.  Washington County Heritage Online 

principally wants to: 

 

 collect items of historical and cultural importance  

 celebrate local history 

 encourage cooperation between archives, historical societies, libraries, museums, and 

other cultural organizations 

 allow for wider access to the unique materials found in Washington County 

 train contributors to adhere to standards that create consistency and allow for WCHO to 

contribute to regional and national projects 

 

When choosing items, particularly textual items, it is important to consider the relative uniqueness 

and importance of the document to the overall history of the county.  For more specific guidelines, 

we have highlighted a few themes and events from Washington County’s history that we feel 

would be good contributions to the collection.  This collection will of course encompass all manner 

of items, but the following list highlights some of the themes and topics that we would like to cover: 

1. Traditional Farm Life and other Labor 

1. Fairs, festivals, etc. 

2. The transition into new types of farming 

3. The move away from agriculture   

4. Union activity  

5. Natural disasters and/or wonders - Tillamook Burn and Columbus Day Storm 

6. Document other important industries in the county, i.e. logging, nurseries, etc.  

2. Oregon Women 

1. Suffrage 

2. WCTU and similar groups 

3. Political action and participation  

4. Work outside the home  

3. Missionary Work 

1. Indian Training School, Forest Grove 

2. Development of Pacific University and Forest Grove   

4. Urbanization/Suburbanization  

1. Politics/dissent  

2. WWI/WWII: bond drives, drafts, CCC and WPA activities   

5. Leisure Activities   

1. Clubs and Groups: bands, Templars, Granges, Masons, Order of Odd Fellows 

2. Technology: electricity, phone, TV, electric rail lines, technology companies 

3. Sports and equestrian activities    

6. Diversity and Growth in the second half of the 20th Century 

1. The dramatic changes in diversity and building in the post-WWII period 

2. Variety of different immigrant groups coming into the county, for differing 

reasons   
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File Naming Schema 

Partner’s coding: PUA = Pacific University Archives 

   WCM = Washington County Museum 

   FHFG = Friends of Historic Forest Grove 

   BHS = Beaverton Historical Society 

   BCL = Beaverton City Library 

   FGL = Forest Grove City Library 

   HPL  = Hillsboro Public Library 

   CMS = Cedar Mill Historical Society  

   CML = Cedar Mill Community Library 

THS = Tualatin Historical Society  

NPL = North Plains Public Library 

SPL = Sherwood Public Library 

TPL = Tigard Public Library 

TUL = Tualatin Public Library 

TPR = Tualatin Hills Parks and Recreation  

CC = Centro Cultural 

 

Archives  pic = Photo/Image Collection 

   txt = Textual Items  

 

Photo/Image Collection 

Number/label your photos according to whatever system you use for your collection.  If you do not 

have an organizational system, you will want to start something so you can be sure that you will 

know which photo goes to which digital file in the future. 

Text Collections 

Use whatever identifier you have for the collection to which the item belongs, followed by a 

numerical sequence as you add items from that collection.  This will help you locate the original file 

that the item lives in if you need to locate the item via the digital file in the future. 

Master TIFFs 

PUApic_photo#a.tif 

WCMpic_photo#b.tif 

PUAtxt_collection#_1a.tif 

These files will simply end with the “a” or “b” 

designation. These indicate different parts of 

the object [i.e. front and back] 

 

TIFFs 

PUApic_008001ah.tif 

PUApic_008001bh.tif 

WCMtxt_ms5_002ah.tif 
 
 
 
 

JPEG: 
PUApic_008001ad.jpg 
WCMtxt_MS1_003d.jpg 
PUAtxt_MS5_005ad.pdf  
Add a “d” to denote the derivative file 
Add an “h” to denote the high-resolution image that has 
been corrected in Photoshop 
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File Making Schema Template 

Structure: 
 
iiipic_######sf.ext 
 
 iii = three letter institution code 
 pic = denotes that the file is a picture/image 
 ### = The accession number, cataloging number, etc. used by your institution. Be sure   

  to add leading zeroes in order to insure that your file names have the same character numbers 
  throughout this process 

 S = side of the photo.  For the image of the front, put “a” on the end. For the back, if   
   you scan it, put “b.”  Even if you only scan the front, you must still put the “a.” 
 F = file type. For the Master TIFFs, nothing will be added.  For edited TIFFs, an “h” will  
   be added to the end.  For the Access Size JPEGs, a “d” will be added. 
 
iiitxt_###_##Pf.ext 
 
 iii = three letter institution code 
 txt = denotes that the file is text based 
 ### = The accession number, cataloging number, etc. used by your institution.  
 ## = number assigned to individual item within the collection  
 P = part of the object. Use ‘a,’ ‘b,’ ‘c,’ etc. to denote each part of an item 
 F = file type. For the Master TIFFs, nothing will be added.  For edited TIFFs, an “h” will  
   be added to the end.  For the Access Size JPEGs or PDFs, a “d” will be added. 
 
Examples: 
  
 PUApic_008001a.tif 
  The Master TIFF of the front side of photo 8001 from Pacific University’s collection 
 WCMpic_012003b.tif 
  The Master TIFF of the back side of photo 12003 from WCM’s collection 
 PUApic_008001ah.tif 
  The TIFF of the front side of photo 8001 from Pacific University’s collection, which has been edited in 
   Photoshop 
 WCMpic_012003bh.tif 
  The TIFF of the back side of photo 12003 from WCMs collection, which has been edited in Photoshop   
 PUApic_008001ad.jpeg 
  The Access Size JPEG of the front side of photo 8001 from Pacific University’s collection  
 WCMpic_012003bd.jpeg 
  The Access Size JPEG of the back side of photo 12003 from WCM’s collection 
 PUAtxt_MS1_005a.tif 
  The Master TIFF for the front page of the fifth item added from manuscript group 1 
 WCMtxt_MS6_003ad.pdf 
  The access size PDF for the front of the third item added from manuscript group 6 
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WCHO Scanning Procedures 

Preparation before scanning 

 

Preparing work space 

1. Prepare work spaces and surfaces before beginning. 

2. Clear working space around scanning area of objects, especially those that could mark or 

damage the materials. 

3. Clean area before removing documents for scanning with canned air and brush. 

4. Clean scanner bed with soft anti-static cloth and compressed air. Make sure any residue, 

especially sticky residue, has been removed completely before setting items on bed. 

 

General Guidelines for safe handling of archival items 

1. No food or drink is allowed near the work area. 

2. Wash hands before handling materials. 

3. Do not use pens, markers, or sharp objects near the materials. 

4. Do not use rubber bands, paper clips, or self-sticking notes on the materials. 

5. Don’t slide documents around on top of each other because they may abrade or damage 

each other. 

6. Don’t lift documents tightly by their edges. 

7. Don’t fold or roll documents to make them easier to handle, or close scanner top to flatten 

items. 

 

Safe Handling of documents and flat materials 

1. Use lint-free cotton gloves when handling vulnerable documents. 

2. Keep original items on a flat, well-supported surface. Do not place items on your lap or let 

them hang off the side of a table. 

3. Support fragile paper documents by placing a piece of stiff archival board behind them, if 

necessary, and to aid in turning them over. 

4. Do not stack objects of varying sizes or weights. Do not make stacks too high. 

 

Safe Handling of Photographs 

1. Do not touch the surfaces of photographic emulsions. 

2. Wear clean, lint-free cotton gloves when handling photographs and film transparencies. 

3. Do not try to flatten curled or curved photographs. 
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Flatbed Scanning Procedures 

 Be sure to scan all sides of documents where relevant writing is present.  Also be sure to scan 

any separate documents which describe or identify objects/people in the photo. 

 This guide shows you how to scan using an EPSON scanner.  If you are using your own 

equipment, please consult your scanner’s guide and make sure you comply with the 

guidelines listed here.   

 If the matting of a photo is too big to scan, but the image itself will fit on the scanner, scan the 

item and crop around the image alone.  Then be sure to note that it is a photo on matting in 

the metadata. 

 If the only writing on the back of the photo is information from the museum/archive/etc. and is 

simply for organizational purposes (such as accession numbers, ID numbers, etc.), do not worry 

about scanning the back.  This information will be in the metadata anyway. 

 Do not allow items to hang off side of scanning area without a support. 

 Do not remove items that are encapsulated in a frame etc. 

 

 

1. Open EPSON Scan on the desktop. 

2. Before you start, check scanner setting. 

o Set scanner on Professional Mode 

o Document Type: “Reflective” for non-transparent media. 

“Film with Film Area Guide” for negatives and transparent media. 

o Auto Exposure Type: 

 Photo: photographs & historical handwritten/typed documents (w/ stains, 

discoloring). 

 Transparent items: Choose B&W Negative or Color Negative. 

o At the bottom of the window, click on Configuration: 

 Select the Color tab. 

 Select either ICM or ColorSync. 

 For the Target, select ColorMatch RGB.  

 If Colormatch RGB profile is unable to sync, select No Color Correction. 

o Refer to Best Practices Guide for bit depth, Resolution (dpi), pixel size and file type to 

use. 

 Adjust dpi if necessary to meet the minimum pixel length standard. 

 To find the pixel size, check the lower left corner of the Preview window after you 

do the Preview scan. 

3. Setting filename and saving instructions: 

1. Click the icon next to the Save button on the lower right of the toolbox menu. 

2. Click Browse and select the location of where to save items.  You should have a folder 

with three folders within it: Master TIFFs, TIFFs and Access Size.  Save scans in the Master 

TIFFs file.  Save PDFs in the Access Size folder. 

3. Create a file name using the WCHO File Naming Schemas sheet or create a place 

holder filename while scanning and adjust the names later. 

i. Filenames may need to be adjusted after scanning. Most scanner programs will 

automatically numbered -01, -02 and those number need to be deleted 
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Positioning items: 

1. For negatives: 

i. Remove white cover on top lid. 

ii. Use correct size film holder and place negative face down. 

iii. Position tray so that corner white triangle is touching top/right triangle on scanner.  

2. For photos: 

i. Lay item flat in center of scanner. 

ii. Do not try to force items flat. 

iii. If item will not flatten, use a white archival board to lightly hold over item while 

scanning. 

3. For text items:  

i. Only invert books smaller than 8.5” x 11” 

ii. Never force the spine of a book open 

iii. support the pages with your whole hand with lifting a manuscript or turning the 

pages of a book 

iv. Support items with a stiff archival board if they are larger than the scanner bed 

  

Preview item: 

1. Click Preview to do a preview scan of the item 

2. Check position of item so that all edges are visible with a slight margin, if not, carefully 

reposition item and preview again. 

3. Select the part of the scan that you want included in the file 

v. For documents and prints allow for a slight margin around entire document. 

vi. For negatives, select visible area. 

vii. Don’t worry about being too careful; you can crop and straighten in Photoshop 

later 

4. Click on Scan and save to Master TIFF folder 

a. If doing a PDF, save the PDF to the Access Size folder 

 

Readying Images 

1. Adjust filename 

a. Refer to the WCHO File Naming Schemas if needed 

b. Remove any unnecessary numbers or characters in the filename, such as “-01” or “-02” 

for images with multiple files attached.  Add the “a”, “b”, etc.  

c. For PDFs, save as PDF with correct file name. No other steps are necessary. 

2. Open up file in the imaging software Photoshop. 

a. Refer to Readying Digital Images for instructions. 

 

Saving Tiffs and Access Size files 

1. Make sure to refer to the File Naming Schema to make sure you are labeling everything 

correctly. 

2. Save Master TIFFs with no compression. 

3. For the Photoshop procedures and directions for saving the edited TIFFs and Derivative 

files, see the Readying Digital Files document.  By the end you will have saved three 

different files: the Master TIFF, the TIFF (adjusted in Photoshop), and the JPEG. 
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Color Channels 

Pointers 

WCHO: Readying Digital Files 

Readying Images 

How to create TIFFs and display images using Photoshop.  This guide is for Photoshop CS5.  If you are 

using an older version of Photoshop, or Photoshop Elements, please consult the Help guide on your 

program for instructions on how to complete each of these steps. 

Creating Tiffs 

1. Open image in Photoshop. 

2. For color photos or text items: 

a. Go to Image/Adjustment/Levels 

b. In Levels, adjust the RGB color channel so that the darks and highlights pointer is 

reading the histogram.  If the color of the photo looks like it needs adjustment, check 

each color channel (Red, Green, Blue) and adjust the darks and highlights pointer so it 

is reading the histogram. 

 

 

 

3. If necessary, also adjust lighting in Image/Adjustments/Brightness & Contrast  

4. Check Color Balance for obvious color casts. 

5. To adjust color, go to Image/Adjustments/Color Balance  

a. Move levels to the opposite side of the color cast visible to correct. 

b. Avoid extreme color adjustments. 
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6. For black and white photos, go to Image/Adjustments/Brightness & Contrast 

a. Check the Contrast & Brightness and adjust is necessary 

 

 

b. You can also go to Image/Adjustments/Black & White and adjust levels there 

 

 
 

7. Adjust image alignment using Edit/Free Transform  

a. Make a new layer by right-clicking the background and making a copy 

b. To gauge the alignment, use Rulers to pull down guides. 

c. Find them under: View/Rulers 

d. For guides, go to View/Show/Grids. 

e. Rotate the layer with the dual-ended, curved arrow that appears when you hover near 

the bottom of the box that appears when you choose Free Transform 

f. Hit Enter when you are satisfied with the image’s alignment  

8. For photos, crop the image so that the edge of the photo is showing.  For slides and negatives, 

crop as close to the edge of the image as possible. 

9. Anytime you do something you do not like, you can use the History to undo actions.  

Photoshop will save a list of your last 20 actions in the history panel on the right. 
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10. Sharpen image using Unsharp Mask 

a. Go to Filter/Sharpen/Unsharp mask  

b. Use settings: Amount 50%; Radius 0.9 pixels; and Threshold of 0. 

c. Slowly sharpen in these increments; avoid over sharpening. 

 

 

 

11. Save new image to the external hard drive or server you have been using. 

a. File/Save as 

b. See File Naming Schema document for file name. Edited TIFFs should have an “h” on 

the end of the file name 

i. Example: PUApic_8001ah.tif 

 

12. Save as a Tiff with 

i. Image Compression = None 

ii. Pixel Order = Interleaved  

iii. Byte Order = IBM PC 
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Make sure these are 

ALL checked 

 

If you have created any additional layers, such as when you create a layer to do a Free Transform 

rotate, choose the option to “Discard Layers and Save a Copy” 

Creating a Display Image 

1. Change Image Size: Image/Image Size 

a. Make sure Scale Styles, Constrain Proportions, and Resample Image are all checked 

before making any adjustments. 

b. Change to Resolution first to 72 pixels/inch 

c. Pixel dimensions should be 600 pixels on images longest side  

i. Only go above 150 dpi if it is impossible to achieve 600 pixels along the longest 

size 

ii. Once you click OK, view the re-sized image at 100% and determine if the size 

looks acceptable to online viewing.  Adjust if necessary. 

 

 

 

2. Sharpen once with Unsharp Mask filter. 

3. Save the file on the external hard drive or server you have been using. 

a. File/Save as 

b. See File Naming Schema document for file name. JPEGs should have an “d” on the 

end of the file name (for Derivative) 

i. Example: PUApic_8001ad.jpeg 

 

**Always use “Save As” for the TIFFs and JPEGs so you are saving a NEW file, and not saving over the 

Master TIFF** 

Useful keyboard short-cuts: 

CTRL-+ Zoom In 

CTRL- - Zoom Out 

CTRL-z Undo 

CTRL-‘ Show Gridlines 
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Collection Building Overview 
 

Before you begin 

 

These are the minimum requirements for the CONTENTdm Project Client: Microsoft Windows® XP with 

SP2 or SP3 32-bit, Windows Vista 32- or 64-bit, or Windows 7 32- or 64-bit.  

 

Understand Collections and Projects within CONTENTdm:  

 

Collections: Each institution has one collection, and projects are contained in collections. Each 

project can contain many items, and each collection can contain many projects.  

Projects: In the Project Client items are processed in a project. When a project is created, a project is 

linked to a single collection. You will already have a project set up; below you will learn how to add 

items to the project, upload items to a collection on the server, and view those items with your Web 

browser.  

 

Work with a project 

 

Create a new project 

 

1. When you open the Project Client, you will have a collection for your institution set up.  This 

collection will also already have a ‘Project’ for you to work in.  Open your project and you can 

add items. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

Project Tab 

Collection Name 

Project name will 

also appear here 
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Add a single item 

 

1. Navigate to the Home tab or Project tab.  

2. On the left task pane under Common Tasks, click Add item or select Item from the Add menu. The 

Add Item wizard opens.  

3. Click Browse to locate the file you want to add.  

4. Click Add once you have selected your file.  

5. A summary screen displays confirmation or any errors or warnings.  

6. Click Close. The item is displayed in the project spreadsheet.  

 

 
 

Add a single PDF file 

 

*To view the PDF in the Project Client, confirm that Adobe Reader is installed on your machine. 

 

1. Confirm that the file extension is .pdf. 

2. If your PDF file contains more than one page, check your project settings and make sure that PDF 

conversion is disabled for multiple-page PDF files.  You can also choose to enable the conversion 

of multiple page PDFs into multiple files.  See the screenshots below for more explanation about 

the difference between these two methods. 

a. This setting can be turned on and off in Project>Project Settings Manager>Processing 

3. Confirm that the PDF file is not encrypted or locked (If it is encrypted or locked, a thumbnail may 

not be generated and text is not extracted). 

4. Follow the above instructions for adding an item. 

 

*Note: You can import multiple, single-PDF files using the Add Multiple Items wizard. 

When the file is added, a thumbnail is automatically generated. (Alternatively, you can use Images & 

Thumbnails settings to select a custom thumbnail for all PDF files.) 

 

 

 
 

This is a single PDF file that is comprised of one page. Single PDF files with multiple pages will also look 

like this, but when you view the file all of the pages will be viewable when the user scrolls down. 

Click link to view 

the item 
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This is a single PDF file with multiple pages that has been loaded with the multiple-page PDF File 

Conversion setting turned on.  There is a top-level for the object, but then each page of the object 

stands alone and can have its own metadata entry. 

 

**You may put transcriptions in the Transcription field, which can be done using an OCR program or 

by hand.  OCR is not available as part of the CDM Project Client. However, you may find more 

information about OCR software online. Many tools are available for free. WCHO staff will not be 

able to support your OCR software 

 

Add multiple items (a folder-full) 

 

1. Navigate to the Home tab or Project tab.  

2. On the left task pane under Common Tasks, click Add multiple items or select Multiple Items from 

the Add menu. The Multiple Items wizard opens.  

3. Select Import from a directory.  

4. Click Browse to locate the directory containing the items that you want to add. Click OK then click 

Next.  

5. Select the option to generate display images.  

6. Click Next. The Confirm Settings screen displays. Review the settings and click Add Items or click 

Back to change your settings.  

7. A summary screen displays confirmation or any errors or warnings.  

8. Click Close. The items are displayed in the project spreadsheet.  
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Add metadata 

 

1. Double-click a thumbnail image in the project spreadsheet. The item opens in a new tab.  

2. Type your metadata into the form.  

Note: When typing multiple terms in a controlled vocabulary field, separate them with a 

semicolon. 

Note: You can also click in the spreadsheet fields and type metadata. It is up to you whether 

you like working in the spreadsheet view or the form view.  Keep in mind that in the form you 

will be able to see the controlled vocabulary lists; you will not see them as you work directly in 

the spreadsheet.  

3. When finished, click Save before closing the Item tab.  

 

Spreadsheet view 

 

 

 

Upload items to server 

 

 

 

 

This is the spreadsheet view, where you can double-click in the boxes and enter your metadata. 

 

 

 

 

 

Form View 

 

 
 

4. On the Project tab, select the items you want to upload from the project by selecting the 

checkbox in each item row or click Select All.  

 

4. Click Upload for Approval. Selected items are uploaded and the status bar at the bottom of the 

Project Client indicates progress.  

Your auto-fill fields will appear here.  You will also 

be able to see the controlled vocabulary for a 

field when you click on it.   
A new tab will appear 

with the object’s title 

Use these 

three 

buttons to 

navigate 
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3. When the upload is complete, the administrator can review the pending queue and approve the 

items. Erica Findley will be the administrator checking the metadata. 

 

View items 

 

Browse collections * 

1. In your browser’s address bar, go to the CONTENTdm Website URL for WCHO. 

2. The site is http://washingtoncountyheritage.com.  

3. Select your institution in the Advanced Search to view only objects from your institution. 

 

*There will be a lag between uploading for approval and the items appearing on the WCHO website. 

 

Adding Compound Objects 

1. Navigate to the Home tab or Project tab.  

2. On the left task pane under Common Tasks, click Add Compound Object from the Add menu. The 

Multiple Compound Objects window opens.  

 

 
 

 

 

 

 

 

 

 

Click here 

OR here to 

select items 

Click this link 

to upload the 

items 

http://washingtoncountyheritage.com/
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3. In the Add Multiple Compound Object window, select Add using the Compound Objects Wizard. 

 

 
 

4. A window will appear.  Choose the type of compound object you are going to add. 

 

 

 

 

 

 

 

 

 

 

 

 

5. Click Browse to locate the directory containing the items that you want to add. Click Next. All parts 

of each compound object will need to be in separate folders on your computer. 

 

6. Use the file names as titles for now.  They can be changed when writing the metadata. 

 

 
 

 

 

Document lets you create multiple sequential pages of a 

report, journal, photo album, or related image sets. 

 

Monograph allows you to retain the hierarchical structure of 

documents, including sections, chapters, and pages. 

 

Picture Cube lets you select up to six images to link together 

views of a three-dimensional object.  

 

Postcard holds both the front and back images of two-

sided items, such as tickets, flyers, and baseball cards. 
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7. After clicking Next, the compound object will appear in the Add Multiple Compound Objects 

window.  Repeat process as many times as needed to add more Compound Objects. Then click 

Finish.  

 

.  

 

To import a multiple-page PDF files as a compound object 

1. Confirm that the file extension is .pdf. 

2. Check your project settings and confirm that PDF conversion is enabled for multiple-page PDF 

files.   

a. The setting is under Project>Project Settings Manager>Processing 

3. Confirm that the PDF file is not encrypted or locked (if it is encrypted or locked, a thumbnail 

may not be generated, text is not extracted, and it is added as a single-item PDF file. You 

cannot create a PDF compound object from an encrypted or locked PDF file). 

4. Follow the instructions for adding a compound object item. 

Note: You can import a batch of multiple-page PDF files by using the Compound Object 

Wizard. 

 

This is a compound object consisting of four multiple page PDFs.  Each of the sections can 

have its own metadata, along with top level metadata for the items as a whole.  For example, 

this is an option for items such as books, where each file could be a multi-page PDF of a 

chapter or section. 
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When the file is added, thumbnails are automatically generated (alternatively, you can use Images & 

Thumbnails to select a custom thumbnail for all PDF files). 

** You may put transcriptions in the Transcription field, which can be done using an OCR program or 

by hand.  OCR is not available as part of the CDM Project Client. However, you may find more 

information about OCR software online. Many tools are available for free. WCHO staff will not be 

able to support your OCR software 

Writing Metadata for Compound Objects 

 

1. The summary window will appear saying the objects have been uploaded.  They will appear in the 

spreadsheet.  Metadata should be written in the Spreadsheet View for Compound Objects. This is the 

item level metadata. In this view, you can right-click on each field and choose ‘Fill Compound 

Object’ to make sure all parts of the object have the metadata you’ve written attached to it.  

 

 
 

2. If you double-click the object and enter the Form View, you can change the titles for the different 

parts of the object.  Use ‘front,’ ‘back,’ and ‘note.’  If you have more than three parts, or if these 

terms are not applicable, write in different terms and stay consistent to the pattern you set down for 

yourself.  

 

 
 

10. Check the box next to the objects in the Spreadsheet View once you are done writing metadata.  

Click Upload for Approval. Selected items are uploaded and the status bar at the bottom of the 

Project Client indicates progress. 

 

Editing Metadata that is in CONTENTdm 

Using the Project Client, you can retrieve and edit items from your CONTENTdm collection.  

First, search for the items and download them from the collection into the Project Client project. Next, 

edit the items. Then, upload the items to the pending queue for approval and addition to the 

collection database. 

Note: When you download items from a collection into your project, the items are locked from 

editing by other users but are still available for viewing in the web interface. 

Title will need to be 

changed for all 

parts of the object. 

Metadata you 

write in the 

Spreadsheet View 

will appear on all 

pages of the Form 

View. 
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To edit items: 

1. Open the Project Client project that is associated with your collection. 

2. Click the Find in Collection tab. 

 

3. Browse for the items in the collection by clicking Browse Collection or conduct a search by 

typing keywords in the search box and clicking Search (or construct a more detailed search 

by clicking Advanced Search).  

 

 

 

 

 

 

 

Tip: You can change the number of search results shown per page. Click the drop-down list 

next to the Search button to select from 100, 500, 1000 or 5000 results per page. 

 

 

 

This is the Advanced 

Search Box.  This 

allows a lot of 

customization, and 

you can save 

searches 
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4. Search and browse results are displayed. 

 

5. Locate the item(s) to edit, and select the checkbox. Then click Add to Project (Edit). 

The selected items are added to the Project Spreadsheet and a locked icon displays and the 

item rows change color on the Find in Collection tab. 

      

Note: Although you can add more than 10,000 items at a time, we recommend downloading 

less than 10,000 items at a time from the server to maintain acceptable download times. 

6. Click the project tab and edit the items(s). When you have finished editing the items, select 

the items and click Upload for Approval. Items will be sent to the pending queue for approval. 

 

Editing Notes:  

 If you exit the current project while still editing items, your items are saved until they are 

uploaded to the pending queue. 

 If you download and then delete an item from your project (whether or not you make any 

changes), the item is unlocked and returns to its original state within the collection. 
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 Project additions, updates, and deletions are automatically saved to your project when you 

close it. 

User and network support 

 

If you have problems with CONTENTdm, please contact the support center.  Only contact Erica 

Findley if you have problems directly related to WCHO.  

 

Help Files: www.contentdm.org/help6/  

User Support Center: www.contentdm.org/USC/  

Tech Support: 1-877-797-0887  

Support is available 7:00 am–9:00 pm U.S. Eastern Time, Monday through Friday.  

E-mail: contentdmsupport@oclc.org 
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Cataloging Objects for the 
Washington County Heritage Online digital collection 

 
General Notes when entering information in CONTENTdm: 

1. Replace quotation marks within fields with apostrophes. 

2. Include the file extension for the digital filenames. (.jpg) 

3. Remove special characters from file names. Special characters are: \ : * ? " < > | 

a. Special characters are OK in your metadata fields if they are necessary, such as in the 

transcription field 

 

Required fields to be entered** 

For all other fields enter only if information is known, otherwise leave blank or set to the default 

setting. 

 Identifier 

 Title 

 Description 

 Digital Publisher 

 Type 

 Date digital 

 Digitization specifications 

 Cataloged by 

 Cataloged date 

 

**Note: The Date-Created and Date.Range fields are not required, but if you fill in one, you MUST fill in 

the other. 

Identifier (A) REQUIRED 

 An unambiguous reference to the resource conforming to a formal identification system within 

a given context. 

 Can be the accession or catalog number assigned to the object. 

 

Examples:  PUApic_009718 

   WCMtxt_012031 

 

Title (B) REQUIRED 

 The collection or item-level name of a resource; a caption. 

 Descriptive yet brief, no more than 30 characters when possible. 

 For a text item, transcribe the title from the item itself. 

 Any written evidence on the front or back of a photograph should be placed in the 

Transcription field.  

 If no information is found, then devise a title using following format: 

Format titles (Graphic Materials - rules 1.C.2):  

 Main Subject(s) – depicted (persons, events, activities, or objects) 

 Geographical location(s) depicted, if known and significant 
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 Date or date spans of what is being depicted, if different from the publication or 

execution dates. 

 

Examples:  New York Pilots’ Association membership certificate 

    Portrait of Cyrus Patten 

    Gen. Emiliano Zapata and his staff, Puebla, Mexico, 1911 

    Whitman, Marcus. Letter to Alanson Hinman 

    Board of Trustees meeting minutes, 1922 
 

Creator (C) OPTIONAL 

 Names of persons and corporate bodies having contributed to the creation of the resource. 

 Formatting: Last name, First name, Middle name or initial. Place spaces between initials. 

 When in doubt, do not invert; give the name as it appears. 

 List multiple Creators in order of their appearance or importance.  

 Separate each entry with a semicolon. 

 Include brief biographical information, if known, of birth-death dates, and function or 

role of the creator/contributor.  

Use standardized values to indicate function: 

 photographer 

 editor 

 illustrator 

 publisher 

 To determine correct format of names and years, if available: 

1. First check the local database or source information for listed names. 

2. Then look for names at Library of Congress Name Authority (http://id.loc.gov) 

3. If they are a known photographer, check Getty Union List of Artists Names for 

artwork (http://www.getty.edu/research/tools/vocabulary/ulan/). 

 List secondary contributors in the Contributors field. 

 If the creator is unknown, leave the field blank. 

 

Examples: Jackson, Michael Smith, author 

Jackson, William Henry, 1843-1942, photographer  

Unidentified photographer with a studio in Forest Grove, Oregon 
 

Description (D) REQUIRED 

 Description of the content of the resource, not the resource itself. 

 Enter descriptive text, remarks, and comments about the digital object. This information can 

be taken from the object or through other sources.  Use full punctuation. 

 Enter here specialized information not included in other elements, for example, description, 

technique, and distinguishing features if observable in the digital object.  

 

Examples: Photograph originally published in the University Catalogue, 1925. 

Diary kept by Louis Parsons of Burlington, Iowa. Parsons grew up in Burlington 

during the 1870s and 1880s. His father, Albion, owned a general store, while his 

mother, Mary, raised Louis and older sister Ella. Louis’ father died when he was 13. 

 

http://id.loc.gov/
http://www.getty.edu/research/tools/vocabulary/ulan/
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A woman and a child in a horse-drawn buggy; they are identified on the back 

as Mrs. Merrick and Charlotte.  They drive on Garden of the Gods Road, by White 

House Ranch. 

Transcription (E) OPTIONAL 

 Use this field to add a transcription of text documents. 

 For photographs, transcription of handwritten or typed notes on the item. 

 For photographs, use only when there are notes added to the item. Use the description field to 

transcribe signs or other text in a photo. 

 For photos, indicate if the writing is on the front or back. 

 

Examples: The beautiful croquet set you sent me, arrived this morning in fine condition. Oh 

how good of you, to re-member so generously! Had you heard the exclamations 

of surprise and delight, when the pkg. [package] was opened, you would know 

how fully, your choice gift is appreciated. 

[back] For Pacific University Archives 

[front] To President Richie. Thanks for all the neckties. 

Extent (F) OPTIONAL 

 Use this field to describe the length in volumes, pages, leaves, minutes, or seconds of an item. 

 

Examples: 2 volumes bound together 

   25 leaves 

   3 pages 

   3:16 (3 minutes 16 seconds) 

 

Contributors (G) OPTIONAL 

 The person(s) or organization(s) that made significant contribution to the resource but whose 

contribution is secondary to any person(s) or organization(s) already specified in a Creator 

field.  

 Follow the same formatting guidelines as the Creator field. 

 Examples of a contributor include editor, publisher, transcriber, illustrator, photography studio, 

etc. 

 

Examples:   Detroit Photographic Co., publisher 

Heart of Oaks Yearbook, publisher 

Bronson, Danni, editor 
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Digital Publisher (H) REQUIRED 

 Person or Corporate/ Organizational entity responsible for producing a resource or a digital 

copy of a resource. 

 

Examples:  Pacific University Library 

   Washington County Museum 

 

Subject.Topic (I) OPTIONAL 

 Significant topics, events, or activities depicted or described in the item. 

 Use as specific a heading as possible 

 Do not mix broad and specific terms. 

 Separate each entry with a semicolon. 

 Subject terms are derived from this authority source: 

 Library of Congress Subject Headings: http://id.loc.gov/authorities/subjects.html  

 

Examples: Students 

       Baseball teams 

        Badminton 

        Pioneers 

 

Subject.Place (J) OPTIONAL 

 The location depicted or described in the item. 

 Use as specific a heading as possible.  A full list of places in Washington County is included 

with the WCHO information. If you need a place name outside Washington County, check an 

authoritative source for spelling and use the same format. 

 Separate each entry with a semicolon. 

 Subject terms are derived from this authority source: 

 McArthur, L. A., & McArthur, L. L. (2003). Oregon Geographic Names. Portland: 

Oregon Historical Society Press. 

 

Examples: Forest Grove, Oregon 

   Beaverton, Oregon 

   Washington County, Oregon 

[example for outside Washington County] Tacoma, Washington  

 

Subject.Person (K) OPTIONAL 

 Any people depicted or described in the item. 

 Separate each entry with a semicolon. Put a space between initials. 

 Name headings are derived from this authority source: 

 Library of Congress Name Authority File: http://id.loc.gov/  

 If a name cannot be found in the authority source use: Last name, First name, Middle Name or 

Initial 

 Do not invert the name if it is unclear which name is the surname; use the name as it appears. 

 There is a list of names entered into this field. If you would like to consult the list to see if the 

person depicted or described in your object has already been entered you may do so. This is 

optional. 

http://id.loc.gov/authorities/subjects.html
http://id.loc.gov/
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 For text items; enter the author in the Creator field. Enter names in the Subject.Person field for 

works about that person. 

 

Examples:  Ritchie, M. A. F. (Miller Alfred Franklin), 1909-2000 

   Toth, A. J.  

   Moses, Grandma 

Madonna 

 

Subject.Theme (L) OPTIONAL 

 Themes that correspond to Oregon curriculum standards or other vocabularies relevant to 

educators. 

 Separate each entry with a semicolon. 

 Name headings are derived from this authority source: 

 America History and Life subjects: http://www.ebscohost.com/titleLists/31h-

subject.htm look in the subject column [only available at Pacific University – but all 

terms are on the printed list] 

 

Examples: United States History 

Local & State History 

   African American History 

 

Language (M) OPTIONAL 

 A language of the intellectual content of the resource. 

 Visual images do not usually have a language unless there is significant text in a caption or in 

the image itself. 

Formatting:   

 Use the ISO 639-2 scheme: Codes for the Representation of Names of Languages Part 2 

http://www.loc.gov/standards/iso639-2/englangn.html 

 In addition to using language codes, if needed, a textual description of the nature of the 
language may be included in the Description element.  

 

Examples: 

[chi] Chinese 

[eng] English 

[fre] French 

[ger] Germany 

[jpn] Japanese 

[spa] Spanish 

 

 

 

 

 

http://www.ebscohost.com/titleLists/31h-subject.htm
http://www.ebscohost.com/titleLists/31h-subject.htm
http://www.loc.gov/standards/iso639-2/englangn.html
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Rights & Usage (N) OPTIONAL 

 Information about rights held in and over the resource. 

 Copyright & intellectual property permissions concerning legal use, access and reproduction 

of a resource can be determined by the holding institution on a case by case basis. 

 Can be different for each institution. Indicates where item is held, who to contact for 

fulfillment, and contact information. Rights statements should provide references or contact 

information. Additional clarification can be indicated via linking to an institutional policy 

statement or other web resource. 

 Use this boilerplate for photos: Online access to this image is for research and educational 

purposes only.  To inquire about permissions, order a reproduction, or for more information, 

please contact [institution name and point of contact information]. 

 Use this boilerplate for text: Online access to this item is for research and educational purposes 

only.  To inquire about permissions, order a reproduction, or for more information, please 

contact [institution name and point of contact information]. 

Example:  Online access to this image is for research and educational purposes only.  To 

inquire about permissions, order a reproduction, or for more information, please 

contact the Pacific University Archives at archives@pacificu.edu. 

Type (O) REQUIRED 

 The characteristic that identifies a resource genre. 

 Use DCMI Type Vocabulary for controlled list of authorized terms: 

http://dublincore.org/documents/dcmi-type-vocabulary/. 

 

Examples:  Still Image 

Text 

Moving Image 

Sound 

 

Date-Created (P) OPTIONAL 

 A concise description of the date or range of dates associated with the creation of the 

object. If using circa, do not capitalize. Use YYYY-MM-DD format for exact dates. 

 If you fill in this field, you must also fill in the Date.Range field. 

 Use guidelines provided for determining how to format a date or date range. 

  

 Examples: 1889 

   circa 1895 

   circa 1920s 

   1991-12-01  

   1880-1885 

 

 

 

 

 

 

 

 

mailto:archives@pacificu.edu
http://dublincore.org/documents/dcmi-type-vocabulary/
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Date.Range (Q) 

 The year or range of years expressed in the Date-Created field. 

 If you fill in this field, you must also fill in the Date-Created field. 

 Use only the format yyyy for a single year or yyyy-yyyy for a range of years. 

 See table used to associate ranges of years with ranges of dates. 

 

Date Created Date.Range 

circa 1990 1990 

circa 1990s 1990-1999 

circa early 1990s 1990-1994 

circa mid 1990s 1993-1997 

circa late 1990s 1995-1999 

1990 1990 

1990-1992 1990-1992 

1990-09-13 1990 

1990-09 1990 

Twentieth Century 1900-1999 

circa1990s-2000s 1990-2009 

circa late 1990s-2000s 1995-2009 

 

Format.Original (R) OPTIONAL 

 The physical manifestation of the resource. 

 Use as many terms as applies to the resource. 

 Subject terms are derived from this authority source: 

 Getty Art and Architecture Thesaurus (AAT): 

http://www.getty.edu/research/tools/vocabularies/aat/index.html  

 

Examples: photographic prints 

  gelatin silver prints 

  card photographs 

copy prints 

cartes-de-visite 

  tintypes 

drawings 

engravings 

personal papers 

scrapbooks 

diaries 

 

Shelf Location (R) OPTIONAL 

 A call #, classification #, or other identifier that would aid in the location of the physical item 

on the shelf or in the institution that holds it. 

 

Examples:  MS95 

    N 3361 .R5 1554 

    Larry Oglesby Collection, Morro Bay FT, bin #8 

 

http://www.getty.edu/research/tools/vocabularies/aat/index.html
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Source (S) OPTIONAL 

 Text description including Collection Name, Accession Number, Physical Dimensions for 

graphic materials and Repository information. Or collection name and location.  

 Enter information about the original item before digitization as follows: collection name, name 

of box, number of bin.  

 

Examples:   Photo Image Collection, Pacific University Archives 

   Larry Oglesby Collection 

 

IsPartOf (T) OPTIONAL 

 A citation or other reference to the work that the item is a part of. 

 

Examples:   First chapter of: Diary of a Sea Voyage to San Francisco and Commonplace 

Book of an Immigrant to Oregon, 1852 

   Sidney Harper Marsh Collection 

 

Date.Digital (U) REQUIRED 

 Date that the item was digitized. 

 Prefer ISO 8601 W3C Date/Time Format YYYY-MM-DD 

 

Examples: 2011-07-05 

   2009-10-14 

 

Digitization Specifications (V) REQUIRED 

 Scanner settings, software used, and specifics about file format.  For dpi, insert the actual dpi 

of the Master TIFF. 

 

Boilerplate*: Scanned at [###] dpi using an Epson V700 scanner. Images enhanced in 

Photoshop CS5. Saved as the highest resolution TIFF and also a derivative JPEG. 

 

   Scanned at [###] dpi using an Epson V700 scanner.  Saved as a PDF. 

 

*Be sure to adjust this if you are using your own equipment 

 

Cataloged By (W) REQUIRED 

 The initials of the individual(s) creating the metadata record. It will facilitate administrative 

functions including workflow and quality control. 

 Enter initials in capitals without punctuation. 

 

Examples: JAD   (Jane A. Doe) 

   JS (John Smith) 
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Cataloged Date (X) REQUIRED 

 Used to enter the date the digital item was cataloged. 

 Enter the date the record is cataloged in YYYY-MM-DD format.  

 

Examples:  2001-10-12 

   2011-09-28 
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Controlled Vocabulary 

Lists 

Please see the Wiki for the most up-to-date lists for:  

Subject.Topic 

Subject.Name 

Subject.Theme 

Format Original 

 

http://washingtoncountyheritageproject.pbworks.com  

 

 

 

 

http://washingtoncountyheritageproject.pbworks.com/
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Forms for Participants 
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WCHO Participant Agreement 
 

Name of Institution: __________________________________________________________________________ 

 

Address: ____________________________________________________________________________________ 

 

Phone: ______________________________Fax: ___________________________________ 

 

Is hereby providing the collection described in the Washington County Heritage Online (WCHO) Project 

Worksheet for inclusion in WCHO. I understand and acknowledge this collection of digital objects (metadata 

and scanned images) will be hosted by OCLC (Online Computer Library Center) under the terms of the Pacific 

University installation of CONTENTdm. The collection will be stored in the WCHO digital repository and made 

accessible to both researchers and casual users searching WCHO. I also understand that the contribution of 

these digital objects enhances the overall value of the regional repositories (i.e. Northwest Digital Archives, 

WorldCat Local, Oregon Digital Library) and therefore will make every attempt to allow and foster continued 

access through WCHO of my organization’s collection(s).  My institution will be given access to the support 

materials at the online CONTENTdm Support Center, but will continue to receive live CONTENTdm support from 

Pacific University and the Washington County Museum (WCM).   

  

My institution will contribute and maintain this collection in accordance with WCHO Best Practices Guide, 

including any enhancements, updating and/or revision of metadata to ensure its continued accuracy and 

quality.  My institution also agrees to self-submit our materials.  WCHO will provide my institution with a 

customized CONTENTdm Project Client for this purpose. 

 

I have ascertained that my institution holds the necessary access rights to make this digital collection 

accessible to searchers of WCHO. My institution will also make a reasonable effort to ensure copyright 

compliance for items in our collection. WCHO, the Washington County Museum, and Pacific University will not 

be held responsible for any direct, indirect, consequential, or incidental damages arising out of or relating to 

the use of the information and materials linked to or found on the WCHO website. My institution will be fully 

responsible for the content of our collections in WCHO and indemnify and hold harmless the Library, Pacific 

University, WCM, and the employees and agents thereof, from any claims, losses, damages or legal actions 

incurred by the Library, Pacific University, WCM, or the employees or agents thereof, and arising from the 

content or dissemination of the content. 

 

Please sign a copy of this agreement, and return to the WCHO Project Manager. She will then sign it and return 

a copy for your files. Return to: Lindsay Zaborowski, Pacific University Library #A124, 2043 College Way, Forest 

Grove, OR 97116. 

 

Washington County Heritage Online 

 

___________________________________________________________________________ 

Lindsay Zaborowski, Project Manager 

 

___________________________________________________________________________ 

Date 

 

Contributing Institution  

 

___________________________________________________________________________ 

Signature and Date 

 

___________________________________________________________________________ 

Printed Name and Position/Title at your Institution 
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WCHO Project Worksheet 

 

Who will be working on your Project? 

 

 

 

Schedule: 

 

 

 

 

 

Projected Project Length: _________________________________________________ 

 

Goals: 

 

 

 

 

 

 

 

 

Activities: 
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WCHO Metadata Worksheet 

CONTENTdm Project Client Prep 
 

Institution: _____________________________________ 

 

Filling out the following form will enable us to set up some of your Project Client fields to auto-fill.  The 

Digital Publisher, Type, and Source fields will be auto-filled unless you direct otherwise.  Filling in your 

identifier format will help us insure compliance with the File Naming Schema.  The contact name and 

e-mail for the rights statements will help us to make personalized Rights and Usage boilerplates for 

your institution.  

 

You will have the option at any point to have other metadata fields auto-filled. 

 

1. Identifier format: ____________ 

2. Digital Publisher: ____________________________________________________________________ 

3. Rights and Usage:  

i. Online access to this image is for research and educational purposes only. To 

inquire about permissions, order a reproduction, or for more information, please 

contact the __________________________________________________ [your institution] 

at ____________________________________________________________ [e-mail]. 

4. Source: _____________________________________________________________________________ 
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OCLC Holding Symbol Form 

CONTENTdm is run by OCLC (this stands for Online Computer Library Center).  For your collection to 

be in CONTENTdm, and for the collection to be able to be part of library search engines like 

WorldCat, you will need an OCLC Holding Symbol.  If you already have one, just check the box at 

the bottom. You can write the symbol in the space provided if you know it. 

Library Name [40 characters max including space and punctuation] 

___________________________________________________ 

Address ___________________________________________ 

    ___________________________________________ 

City ______________________________________________ 

Zip Code _________ 

Contact Name ___________________________________________ 

Contact E-mail ___________________________________________ 

Associated Library* _________________________________________________ 

Telephone ______________________________________________ 

Fax ____________________________________________________ 

Library OPAC url _________________________________________ 

IP Range (All) ____________________________________________ 

I already have an OCLC Holding Symbol ___________ 

 

 

 

 

 

 

 

 

 
 


